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INFORMATION

Copyright

This user manual and the information provided herein is copyright material. No part of this manual may be duplicated or
reproduced in any form whatsoever without the written consent of the publisher Image Club Graphics, Inc. The Image Club
Typeface User Manual for Macintosh ©1992 Image Club Graphics, Inc. This document printed in Canada.

Trademartks

Adobe, PostScript, Illustrator & Photoshop are registered trademarks and Adobe Type Manager, ATM & Font Porter are trademarks
of Adobe Systems, Inc. PageMaker, FreeHand & SuperPaint are registered trademarks of Aldus Corporation. Apple, AppleTalk,
Macintosh, MultiFinder, LaserWriter & TrueType are registered trademarks and Finder & QuickDraw are trademarks of Apple
Computer, Inc. Microsoft is a registered trademark of Microsoft Corporation. WordPerfect is a registered trademark of WordPerfect
Corporation. MacDraft is a trademark of Innovative Data Design. Fontographer is a registered trademark of Altsys Corporation.
SuitCase II is a trademark of Fifth Generation Systems, Inc. MasterJuggler is a trademark of AlSoft, Inc. TypeStyler is a registered
trademark of Brgderbund Software. Claris & MacWrite are registered trademarks of Claris Corporation. Canvas is a trademark of
Deneba Software. ITC Garamond is a registered trademark of International Typeface Corporation. Futura is a registered trademark
of Fundicion Tipografica Neufville SA. Bernhard Modern is a trademark of Kingsley/ATF Type Corporation. Art & Type Vendor,
Evolution, LetterPress & the “Whoever dies with the most fonts wins” slogan are trademarks of Image Club Graphics, Inc.

Licensing Agreement
The diskettes and/or CD ROM discs that are provided herein may not be reproduced or duplicated in any form whatsoever other
than to supply a single backup copy and one copy for each computer connected to a single printer on a local area network. With
the software, you have purchased a license to use the typefaces enclosed with one single printer. You may make copies of the
bitmap, TrueType and PostScript printer font files to distribute to other computers on your local area network sharing one printer.
If you have more than one printer on your network, it is required that you purchase a typeface package for each printer on your
network. If you will be sending your documents to an outside service bureau for output, it is permissible to supply the service
bureau with a copy of the Image Club typeface for a one time usage only. You are in violation of your licensing agreement if you
give a copy of your fonts to the service bureau for permanent use. For more information on the Image Club Multi User License, the
Image Club Licensing Agreement and the Licensing Agreement Terms & Conditions please read the information on the software

* envelope or call the Image Club customer service department. Please note that you should be familiar with the Licensing
Agreement and it’s terms & conditions before you open the software envelope.

Toolbox

The Image Club Typeface User Manual for Macintosh was written, edited and designed using Claris MacWrite® II L1v2, Adobe
Illustrator® v3.2, Adobe Photoshop® v2.0.1, Aldus FreeHand® v31, Evolution™ v2.0.3 & Aldus PageMaker® v4.2. Screen dumps were
created using Mainstay Capture™ v4.0 & Aldus SuperPaint® v3.0. User manual text set in the ITC Garamond® Condensed &
Futura® families from the Image Club Typeface Library.

Contact
Image Club Graphics, Inc.
Suite 5 1902 Eleventh Street Southeast

Calgary, Alberta, Canada T2G 3G2 ).
Phone 403 262 8008 / Fax 403 261 7013 \\v

Applelink CDA0573 / Compuserve 72560,2323

INTRODUCTION

The Image Club Typeface Library

Type is an important element in the image of any document, product or service. Creative use of type adds recognition, seriousness
or excitement to otherwise everyday design. It can also increase both readability and believability in advertising, publications,
reports and packaging. Like music, type sets the tone, mood or emotion of the document that carries it.

The Image Club Typeface Library has been assembled as a high quality, professional collection of TrueType® and PostScript®
typefaces. Compatible with virtually all Macintosh applications and output devices, the Image Club Typeface Library is a welcome
addition to any desktop publishing system. Image Club fonts are designed with the user in mind, so they are as easy to install as
they are to use. ‘

Image Club guarantees the overall typeface quality by paying a licensing fee to the foundry that owns the name and design of
certain typefaces. You can be assured that when you choose Image Club’s ITC Garamond®, you are getting the real thing. Image
Club typefaces are licensed from several foundries including the International Typeface Corporation, Visual Graphics Corporation,
Fonderie M. Olive, Fundicion Tipografica Neufville SA and the Kingsley/ATF Type Corporation. And of course, Image Club’s own
designers and typographers are developing fresh, new font designs on a continual basis. We feel that above anything else, Image
Club can offer you the broadest, most exciting range of typefaces at the most affordable price.

Throughout this user manual, we hope to bring you the information youw'll need to make the most of your new Image Club
typefaces. Besides information on the installation of fonts and answers to questions that may arise during everyday use, we have
also assembled a collection of some of our favourite type based, graphic design ideas. We hope that you find the information and
tips included in this manual, both useful and fun.
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GETTING STARTED

System Requirements
Fonts from the Image Club Typeface Library can be used on any Macintosh® computer with the following:

¢ A minimum of one megabyte of RAM. A Minimum of two megabytes of RAM if using system 7.0.
# System software version 6.0.2 or later. System software version 6.0.7 or later, including system 7.0 if using TrueType®.
+ A minimum of two 800K floppy drives, or one 800K floppy drive and a hard drive.
& Any PostScript® output device, including laser printers, film recorders and imagesetters.
¢ Any non-PostScript output device,i including dot matrix, inkjet and QuickDraw™ printers,
when used with Adobe Type Manager™ (ATM™).
& Font/DA Mover version 3.8 or later. Font/DA Mover version 4.1 or later if using TrueType.

Backing Up

Before going any further, make a back up copy of your typeface diskette. Do not use or install the fonts from the original diskette.
To make a back up, set the write protect tab on the typeface diskette to the locked position and copy its contents to a new diskette.
Once the copy has been made, store the original diskette in a safe place. This ensures your original copy of your Image Club
typeface diskette does not become damaged. You are allowed to make one copy of the fonts for back up purposes as outlined in the
Image Club Licensing Agreement on the software envelope.
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Product Registration Card
Make sure that you fill out this card

and mail it to us. There are many

advantages to registering.

Master Diskettes
Back up and be safe.

There’s no telling when

a diskette will suddenly

become unreadable.

User Registration

Image Club is a firm believer in customer service and technical support. To obtain the full benefit of the support that Image Club
has to offer, fill out and mail in the product registration card included with the typeface package. By sending this information,
you are recognised as a registered user and will receive upgrade notices, new product information and full technical support.

Read Me First

Occasionally a Read Me file is included on the typeface diskette. This file contains important information relating to this version of
the software. It may also contain information about features, compatibility and installation of the fonts in addition to what is
mentioned in this user manual. Please be sure to read the entire document before using the typefaces.

INSTALLATION INSTRUCTIONS

This section describes how to install Image Club fonts so you can use them in your applications. It contains instructions for
installing PostScript and TrueType fonts under system 6.0 and system 7.0. If you are working with fonts that come with both
PostScript format files and TrueType format files, only install one of these font formats. If you wish to use the PostScript format
fonts, install the bitmap fonts and the PostScript outline fonts. If you wish to use TrueType, only install the TrueType fonts.

INSTALLING FONTS IN SYSTEM 6.0

Under system 6.0, bitmap fonts and TrueType fonts are installed into the System file using Font/DA Mover and PostScript outline
files are copied to the System Folder. You can also install fonts using a font utility like SuitCase II See the section, “Installation
Using Font Handling Utilities” for more information. If you are installing TrueType fonts under system 6.0, you must have the
TrueType INIT installed in the System Folder before you can use the fonts. Current versions of both the Font/DA Mover utility
and the TrueType INIT may be obtained free of charge from your local Apple Computer dealer.

Installing Bitmap & PostScript® Outline Fonts
& Make sure that you have Font/DA Mover version 3.8 or later on your hard drive.
# Check to see if MultiFinder is running. If it is, you must restart your Macintosh without MultiFinder. To do this, select Set
Startup.. from the Special menu. Click on the Finder Only button. Click the OK button. Select restart from the Special menu.
& Insert an Image Club Typeface Library diskette into the floppy drive. If you are installing fonts from CD ROM, please read the
section, “Installing Fonts from CD ROM” on page 8.
¢ The contents of the diskette will look similar to figure 1 below.
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# First, install the PostScript outline fonts.

¢ Double click on the “PostScript®” folder to open it. ‘

¢ Move the folder window so you can see both the System Folder and the contents of the “PostScript®” folder.

# Select all of the PostScript outline files in the “PostScript®” folder window. See figure 2.

& Drag the PostScript outline files to the System Folder. The PostScript outline files must be loose in the System Folder.
The PostScript files must not be inside another folder in the System Folder.

# Next, install the bitmap fonts.

# Double click on the Font/DA Mover utility on your hard drive. The Font/DA Mover window appears.
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figure 3
The Font/DA Mover window.

¢ Click the Open.. button. See figure 3.
+ A file dialog box appears. Click the Drive button until the name of the typeface diskette you inserted appears
at the top of the dialog box. Listed in the dialog box are the contents of the typeface diskette.
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figure 4
Opening the “PostScript®” folder.

+ Select the “PostScript®” folder and click the open button. See figure 4.



INSTALLING FONTS IN SYSTEM 6.0 INSTALLING FONTS IN SYSTEM 7.0
Installing Bitmap & PostScript® Outline Fonts Under system 7.0 bitmap fonts, TrueType fonts and PostScript outline files are installed by dragging them into the System Folder.
# Select the bitmap suitcase file and click the Open button. See figure 5. ¢ You do not require the Font/DA Mover utility. You can also install fonts under system 7.0 by using a font utility like SuitCase IL
See the section, “Installation Using Font Handling Utilities” for more information.
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After the fonts have been copied, another dialog box appears confirming that the fonts were copied. See figure 14.
# Click the OK button.

# If you have other typefaces to install, repeat the above steps for each font family.
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The Font/DA Mover Qpoingtie ¢ Insert an Image Club Typeface Library diskette into the floppy drive. If you are installing fonts from CD ROM,
utility wind “TrueType™” folder.

please read the section, “Installing Fonts from CD ROM” on page 8.
The contents of the diskette will look similar to the window in figure 10 above.

# Click the Open.. button. See figure 7. Double click on the “TrueType™” folder.

+ A file dialog box appears. Click the Drive button until the name of the typeface diskette that you inserted appears
at the top of the dialog box.

# Listed in the dialog box are the contents of the typeface diskette.

+ Select the “TrueType™” folder and click the Open button. See figure 8.

Move the folder window so you can see both the System Folder and the contents of the “TrueType™” folder.
Select the TrueType suitcase files in the folder window. See figure 15.
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@ Select a TrueType suitcase file and click the Open button. See figure 9. ¢ Drag the files to the System Folder.
+ The Font/DA Mover window shows the contents of the TrueType suitcase file on the right and the contents of the ¢ A dialog box appears, asking if you want to put the fonts into the System file. See figure 16.
System file on the left. The System file contains any fonts you currently see in your applications.
# Select all of the TrueType fonts in the list on the right side. Click the Copy button. See figure 10. Lobl bbb bl o
# The TrueType fonts that you selected and copied, appear in the System list on the left side of the window. T T
2 3 : 8 5 figure 16
# Click the Close button on the right side. Click the Quit button. e The “Put these fonts into the System file?” dialog box.

+ If you have other typefaces to install or additional TrueType suitcases, repeat the above steps for each font. o Click the OK button.

¢ If you have other typefaces to install, repeat the above steps for each font family.




INSTALLATION USING FONT HANDLING UTILITIES

Fonts may be installed for use in your applications using font handling utilities such as SuitCase™ II or MasterJuggler™. These

INSTALLING FONTS FROM CD ROM
The previous pages have described how to install Image Club fonts from diskettes. Installing fonts from the LetterPress™ CD ROM
or the Art & Type Vendor™ CD ROM is similar but certain differences should be noted. Please read the following section to
familiarize yourself with installation of fonts from CD ROM.

utilities do not install fonts directly into the System file or the System Folder and make managing and accessing fonts simpler.
In the following example, SuitCase II is used to install Image Club fonts. You should be familiar with your particular font handling

Bitmap Fonts
& Double click on the Font/DA Mover utility on your hard drive. The Font/DA Mover window appears. * Double click on: the “PostScript®” folder to open it
+ Click the Open.. button. # Select the bitmap suitcase file and all of the PostScript outline files in the folder window.
# A file dialog box appears. Locate the “PostScript®” folder that was copied to your hard drive and click the Open button. + M e 0 o che “IeMpe Gl BRI (GEE
¢ Select the bitmap suitcase file and click the Open button.
# Select all of the bitmap fonts in the list on the right side of the Font/DA Mover window. Click the Copy button. Fer'Fruelyje Follts
o The bitmap fonts that you selected and copied, appear in the System list on the left side of the window. ¢ Peubip click o the "Truelygen™ S e G
@ Click the Close button on the right side. Click the Quit button. + Setect the Trnetype Slteuse LIy fn e i S
« If you have other typefaces to install, repeat the above steps for each font. ¢ Drag the filesto'she Ymage Club Soncs folas
PostScript® Outline Fonts & If you have other typefaces to install, repeat the above steps for each font family.
# Double click on the “PostScript®” folder to open it.  Select SuitCase IT from the Apple menu. ‘
# Move the folder window so you can see both the System Folder and the contents of the “PostScript®” folder.
+ Select all of the PostScript outline files in the folder window. TRa T =
# Drag the PostScript outline files to the System Folder. Lauree ot
@ The PostScript outline files must be loose in the System Folder. They must not be inside another folder in the System Folder. i LTI
# If you have other typefaces to install, repeat the above steps for each font. E:::;:?:k
ymbol
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# Double click on the Font/DA Mover utility on your hard drive. The Font/DA Mover window appears. : ]
& Click the Open... button. ——— b.
# A file dialog box appears. Locate the “TrueType™” folder that was copied to your hard drive and click the Open button. . "‘_mb@us .
& Select a TrueType suitcase file and click the Open button. 18035 N Rfgr it Ebon g L4 0603 fr h:iu:tc;seel 1:508 ST s astrragh) dpin: J; I:ﬂfh:; t’h:O P:"’mm G
@ Select all of the TrueType fonts in the list on the right side. Click the Copy button.
# The TrueType fonts that you selected and copied, appear in the System list on the left side of the window. ¢ Click on the Suitcases.. button. See figure 18.
@ Click the Close button on the right side. Click the Quit button. # Click on the Open File(s).. button. See figure 19.
# If you have other typefaces to install, repeat the above steps for each font.
——& Installing From CD ROM Under System 7.0 b b RETERISTITIIEC = erd brive
i # Insert the CD ROM into the CD ROM drive. The CD ROM icon will appear on the desktop underneath the other disk icons. ["" ﬁ
L@ @ Locate the folder containing the font you wish to install. On both the LetterPress™ CD ROM and the Art & Type Vendor™ CD e —
ST ROM, fonts are stored in folders alphabetically. For example, to locate the ITC Garamond family, double click on the CD ROM -m TIrS
/ icon to open it, then double click on the “G” folder. Inside the “G” folder would be an “ITC Garamond®” folder. et i 0
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stalling From CD ROM Under System 6.0

Insert the CD ROM into the CD ROM drive. The CD ROM icon will appear on the desktop underneath the other disk icons.
Locate the folder containing the font you wish to install. On both the LetterPress™ CD ROM and the Art & Type Vendor™ CD
ROM, fonts are stored in folders alphabetically. For example, to locate the ITC Garamond family, double click on the CD ROM
icon to open it, then double click on the “G” folder. Inside the “G” folder would be an “ITC Garamond®” folder.

Double click on the font folder to open it.

If you are installing bitmap and PostScript outline fonts, drag the “Type 1 PostScript®” folder to your hard drive. If you are
installing TrueType fonts, drag the “TrueType™” folder to your hard drive. Note that TrueType format files are not included
with all Image Club fonts.

Follow the instructions below for installing the font files you require. If needed, refer to the step by step screen dumps on
pages 5 and 6 for more information.

f These items need to be stored in special

places inside the System Folder in order to
be available to the Macintosh. Put them

where they belong?
)| (rsvee ds
= The “Put these items where they belong?” dialog box.

*
*

A dialog box appears, asking if you want to put the fonts into the System Folder. Click the OK button. See figure 17.
If you have other typefaces to install, repeat the above steps for each font family.

utility before reading this section. Follow the instructions found in your utility’s user manual for specific directions.

Using SuitCase II
With SuitCase II, fonts are installed exactly the same under system 6.0 and system 7.0.
If you are installing under system 7.0 however, you must use version 1211 or later of SuitCase IL

& Make sure that SuitCase II is installed in your System Folder.

¢ Create a new folder on your hard drive to hold your Image Club fonts. This folder may
be named anything you wish, but for this example it is named “Image Club Fonts”.

& Insert an Image Club Typeface Library diskette into the floppy drive.

# The contents of the diskette will look similar to the window in figure 10 on the page 7.

For PostScript Fomnts

In the dialog box, locate the “Image Club Fonts” folder on your hard drive and click the Open button. See figure 20.
Listed in the dialog box are any bitmap or TrueType suitcase files present in the “Image Club Fonts” folder. See figure 21.
Select a suitcase file from the list and click the Open button.

Repeat for any other files in the list.

Click the Cancel button.

Click the Quit button.

* 6 6 o o o




MANUALLY

DOWNLOADING FONTS

When a document is printed on a PostScript output device, the PostScript outline information of a font is automatically
downloaded from the computer to the memory of the printer. This font information remains in the printer memory only until
another document is printed, even if the next document uses the same font. To save downloiding time and to speed up printing,
the PostScript outline information can be manually downloaded to the printer, so it will remain in memory until the printer is
restarted or turned off. An application such as the Apple LaserWriter® Utility may be used to manually download Image Club
PostScript outline fonts to the printer.

Alternatively, a hard drive can be attached to certain PostScript output devices for font storage. The LaserWriter Utility can be
used to download Image Club PostScript fonts to the hard drive for permanent storage. Fonts downloaded to the hard drive of a
printer will remain there until they are removed with the LaserWriter Utility. To download PostScript outline fonts under system
6.0, use the LaserWriter Utility version 2.0 or later. To download PostScript outline fonts under system 7.0, use the LaserWriter
Utility version 7.0 or later. Full instructions are included in the Help dialog boxes of the LaserWriter Utility application.

Using the Apple Laser Writer® Utility
& Make sure that a PostScript printer is connected to your Macintosh or AppleTalk™ network.
+ Double click on the LaserWriter Utility application.

Download to
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, i Selecting Download ( ) Downlpad Adding fonts to the

fuit =4 Fonts... from the menu. ) Fonts to Download list.

Select Download Fonts.. from the File menu. See figure 22.
To download fonts to the printer’s memory, click the Printer radio button.

Click the Add.. button. See figure 23.

*

*

¢ To download to the printer’s hard drive (if available), click the Printer’s Disk(s) button.

.

# A file dialog box appears. Locate a folder containing PostScript outline fonts and click the Open button.
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ing a PostScript font file to download.

& Select a font from the list and click the Add.. button. See figure 24.
# Repeat for any other fonts you wish to download. Click the Done button when all fonts have been added.
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M Clicking the Dialog box showing
Download button. downloading in progress.

¢ Click the Download button. See figure 25.
& A dialog box appears indicating the progress of the downloading. See figure 26.

Download completed.

Successful downloads: 1 m

Download failures: 0

flgure 27

+ When the downloading is finished, click the OK button. See figure 27.
¢ Select Quit from the File menu.

SELECTING

ACCESSING

USING IMAGE CLUB FONTS

This section of the user manual describes how to access and use the Image Club fonts you have installed into your Macintosh. The
techniques and information presented here can be applied to virtually any application that uses fonts. If you have any problems
when using Image Club fonts, please refer to the Troubleshooting section of this manual.

FONTS

After the Image Club fonts have been installed, they will appear in the font menu of any application you launch. Select a font in
the menu by dragging through the font list until you hilite the name of the font you wish to use. See figure 28. If fonts do not
appear in the menu, please see the Troubleshooting section of the manual for possible causes and solutions.
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Monaco Figare 28

Times Image Club fonts in a font menu.

figure 29
g Italic in the style menu.

Selecting Italic Fonts

Italic versions of Image Club fonts do not appear in the font menu. Instead, you select the Italic version in the Style menu. For
example, the ITC Garamond family consists of the Light, Light Italic, Book, Book Italic, Bold & Bold Italic fonts. However, only the
Light, Book & Bold fonts will appear in the font menu. To access the Light Italic, Book Italic & Bold Italic fonts, you must first
select either the Light, Book or Bold fonts and then choose Italic as the style. See figure 29. Assigning the Italic style to a font that
has an Italic or Oblique version is the correct way to use the true Italic or Oblique font. Fonts that do not have an true Italic
version may be italicised, but the resulting font is a low quality, skewed version of the original non-italic font.

Selecting Bold Fonts

Choosing the Bold style when using an Image Club font does not automatically select the true Bold version of the font. If an Image
Club font has a Bold version, you must select that font from the font menu. For example, the ITC Garamond family has both a
Book and a Bold font. If the currently selected font is Garamond Book and you wish to make'it Bold, hilite the text and then select
Garamond Bold from the font menu. Do not select Bold as the style. Selecting Bold as the style prints a double struck font, not the
true Bold version of the font.

SPECIAL CHARACTERS
Image Club fonts contain many characters the do not appear on the Macintosh keyboard. These characters include math symbols,
accented characters and other special punctuation. The Key Strokes charts below show the position and keystrokes needed to
access standard and accented characters found in most Image Club fonts. Another method of accessing characters that do not
appear on the keyboard is to use the Keys Caps desk accessory. Please be aware that some Image Club fonts have special character
sets that may not include all of the characters found in the Key Stroke charts. These fonts will have a Read Me file containing
information specific to their character sets.

Key Stroke  Character  Shift Option Option Shift Key Stroke ~ Character  Shift Option Option Shift Key Stroke  Character  Shift Option Option Shift
Character Character Character Character Character Character Character Character Character
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Key Strokes for Standard Characters

Accent Key Stroke Available Characters

Grave ° option’ ~ + thecharacter A B I @ U A & 1 & 1

Acute * option e + thecharacter A E I 0 0 4 & 1 6

Circumflex ~ option i + thecharaccer A £ 1 0 0 4 & 1 & q
Tilde ~ option n + thecharacer A N 0 a2 Ao &

Umlavut = option u + the character ACBES R oY A 1 R (R

Key Strohkhes for Accented Characters
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Bitmap Suitcase Files

A bitmap suitcase file contains images of all the characters in a font so it can appear on the screen. A bitmap file can contain
several point sizes of screen fonts for a particular typeface. The bitmap suitcase file also contains spacing and kerning information
for a font. This information is automatically extracted by an application program when displaying the typeface on screen and
printing the font on a printer.

Type 1 PostScripit® Outline Files

The Type 1 PostScript outline font format was originally developed by Adobe Systems, Inc. The main benefit of a Type 1 font is
that it prints cleaner, clearer and faster than a Type 3 font. It is processed differently by the PostScript interpreter in laser printers,
utilizing special mathematical algorithms built into the printer. Since this special processing applies only to Type 1 fonts, text set at
small point sizes looks better than text set with a comparable Type 3 font. Additional PostScript hinting can be added to the Type 1
PostScript font to further increase it’s clarity when printed on lower resolution printers. Other benefits include smaller file size
and compatibility with Adobe Type Manager (ATM). ATM allows rendering of smooth, clean font outlines on the screen, at any size.
In conjunction with ATM, you can also print Type 1 fonts on any non-PostScript printer. Some disadvantages are that they will not
print on some PostScript clone printers, and they cannot contain any characters with greyscale fills or stroked paths.

Type 3 PostScript® Outline Files

Type 3 PostScript outline fonts are sometimes referred to as “User Defined” fonts. This format is a very flexible format and has
been used by font vendors for many years. A Type 3 font can contain just about anything that can be described in the PostScript
language including effects such as color or greyscale fills, stroked path information and complicated composite characters. Type 3
PostScript fonts can be printed by any PostScript printer. Type 3 PostScript outline files are supplied on the LetterPress™ & Art &
Type Vendor™ CD ROMs only. They are not supplied with diskette based fonts, except in the case of some display fonts that are
available in Type 3 PostScript format only.

TruelType™ Suitcase Files

Recently developed by Apple Computer, Inc., the TrueType font format is direct competition for the industry standard Type 1
PostScript format. There are several advantages to the TrueType format. Both character outline information and screen font
information are contained in the same document. Clean, sharp screen fonts and output on nearly any imagesetting device are
possible without the use of ATM because the typeface rasterizer in build into Macintosh system software version 7.0. TrueType
fonts also have the ability to contain large character sets, well beyond the limitations of the 256 character barrier found in
standard encoded PostScript typefaces. However, TrueType fonts can only be used on a Macintosh running system software version
7.0 or system software version 6.0.7 and the TrueType INIT.

Adobe® Fomnt Metrics Files

These files are editable ASCII text files containing width, bounding box, composite element and kern pair data for all characters in
a particular font. The AFM file has a standard format developed by Adobe Systems, Inc. for distributing font metric information
between different programs and computer platforms.

Adobe Illustrator® Files

These files are Adobe Illustrator v1.1 format encapsulated PostScript files containing the outlines of the font as artwork objects.
They can be opened by Adobe Illustrator, Aldus FreeHand or Deneba Canvas 3.0. Once opened, you can edit and manipulate the
individual character outlines of the font and combine them with other PostScript artwork. Adobe Illustrator files are supplied on
the LetterPress™ & Art & Type Vendor™ CD ROMs only. They are not supplied with diskette based fonts.

EPS Files

Some Image Club typefaces come with Encapsulated PostScript (EPS) files. These files are similar to Adobe Illustrator files except
that they cannot be opened or edited. EPS files are ready to use and can be placed into graphics or page layout programs as objects.
After placing into an application, the files can be resized and combined with regular text or other graphics. EPS files are supplied
on the LetterPress & Art & Type Vendor CD ROMs only. They are not supplied with diskette based fonts.

Fontographer® Files

This file is the data base file used in creating the original typeface and its associated bitmap and outline files. Altsys Corporation's
Fontographer® was used to create and digitize all of the typefaces in the Image Club library. Fontographer files are supplied on the
LetterPress CD ROM only. They are not supplied on the Art & Type Vendor CD ROM or with diskette based fonts.

Read Me Files

The Read Me files accompanying Image Club typefaces contain font information and brief installation instructions. These files are
TeachText files, but can be opened in any word processor or text editing program. Simply double click on the file to open it. The
TeachText application is available from any Apple Computer dealer or can be located on most Macintosh system software diskettes.

CREATIVE USE OF TYPE

Many exciting and creative visual effects can be produced using Image Club typefaces. Need a bolder than bold headline? How
about an eye catching banner for an advertisement? There is no need for type to be dull in order to be functional. The following
section demonstrates how to produce several type effects using font outlines. Font outlines can produced from Image Club
typefaces using a variety of methods. Feel free to experiment with your Image Club fonts, you may find the results surprising.

CREATING OUTLINES

Adobe Illustrator® :
¢ Using Adobe Illustrator 3.0 or newer, open a new document. 4 w I

o Using the text tool, type and layout the text you want. See figure 30. figure 30
) ) Typing text in Adobe Illustrator
# Using the selection tool, select the block of text. See figure 31.
# Choose Create Outlines from the Type menu. See figure 32.
& The font outlines are now ready to be modified.
Slignre 31 k
Selecting the text block

Aldus FreeHand®

¢ Using Aldus FreeHand 3.0 or newer, open a new document.
+ Using the text tool, type and layout the text you want. j
« Using the selection tool, select the block of text.
flgure 32
¢ Choose Convert to paths from the Type menu. Text converting to outlines

Other Utilities

Many utility applications are available for converting fonts into PostScript outlines. For example, Image Club’s Evolution™ font
conversion utility can create outlines from Type 1 PostScript, Type 3 PostScript and TrueType fonts. To use outlines created by a
conversion utility, you will have to open up the file containing the converted font outlines with an illustration program like
Adobe Tllustrator or Aldus FreeHand before being able to modify the outlines.

An application such as Brederbund’s TypeStyler® offers a different approach to adding effects to type. It can perform custom
modifications and special effects on Image Club fonts from a library of built in styles. It can then save the text as outlines or as
encapsulated PostScript files ready to place into any page layout program. 3

TIPS & TRICKS
Smooth Outline
Adds a smooth, unbroken stroke to a block of text. Allows much greater control over the appearance of the outline.

top group
» " filled white no stroke

& Align letters, convert to outlines, select all and fill with black.
@ Add a black stroke with a fairly thick line weight. Try 10 points.

bottom group -~ L7
@ Group all characters, copy the group and paste in front. filled 100% black 10 point stroke

# With the copy of the characters selected, fill with white and set the stroke to none.
& When previewed, the characters will have a uniform black stroke around the white letters.
The outline thickness can be adjusted to suit the situation by changing the attributes of the bottom group of characters.

Multiple Outline
Similar to the Smooth Outline but with additional layers of outlining. Each layer of the text block can be assigned a different
stroke weight, color or shade of grey. Experiment to find a combination that you like.

top group
1~ filled 50% black no stroke

& Follow the steps for creating the Smooth Outline, but start with 3 e\
y ’ middle group
a thicker line weight. Try 15 points for the first group. filled white
¢ Copy the first group and paste in front. 5 point stroke  bottom group

5 . - filled 100% black 15 point stroke
« With the copy of the characters selected, fill with white and - :

add a white stroke with a weight of between 5 and 10 points.
& Again, copy and paste the group in front.
# Tor the top group of characters, fill with a third color or shade (50% black in this example) and set the stroke to none.

13
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Hard Shadow
Creates a simple drop shadow underneath lettering. Adds dimension to type, with the letters appearing to float above the page.

ool first group
4 1 filled 100% black no stroke

# Align letters, convert to outlines, select all and fill with black.

¢ Group all characters, then copy and paste the group. -
shadow group —— 7

# Fill the new group with a light grey, somewhere between 15% and 30% black. y
filled 30% black no stroke

This group will act as the shadow being cast by the top group of characters.

¢ Send the shadow group behind the black group. Position it below and slightly
to the right or left of the black group. The black characters should appear as if floating above the shadow.

& If the shadow is appearing over a colored background, set the fill of the shadow to the same shade as the background,
plus approximately 10% to 20% black.

Soft Shadow
Similar to the Hard Shadow but more realistic looking because of the graduated tonal quality of the shadow.

Simulates diffused lighting rather than a harsh, directional light source. Birst gzoup

filled 100% black no stroke

Align letters, convert to outlines, select all and fill with black.

Group all characters, then copy and paste the group. shadow groups

filled & stroked

. y s with progressively lighter shades of grey
Send the grey group behind the black group. Position it below and slightly (50% black to 15% black)

Fill the new group with a medium grey, somewhere around 30% black.

® & o o

right or left of the black group. The black characters should appear as if floating.

*

With the grey group selected, copy it and paste it directly behind all of the existing groups.

# Change the fill of the new group to a slightly lighter grey (around 5% less),
and add a 1 point stroke to the group in the same shade of grey.

# Again, copy the currently selected group, paste it in behind directly behind the existing groups, lighten the shade of the fill
by 5 per cent and add a 1 point thicker line weight. This will give a lighter, wider shadow behind the first shadow.

# Continue copying, pasting and changing the attributes of the groups until you have approximately 8 to 10 shadows built up
underneath each other. Each group in the shadow should be slightly lighter and heavier than the one in front of it.

« If the shadow is appearing over a colored background, add the same amount of background color to the grey that makes up

each layer of the shadow.

Soft TIFF Shadow
Similar to the Soft Shadow but even more realistic due the smooth, gradated tonal range of the shadow. Since the shadow is a grey
scale TIFF image rather than an EPS graphic, there is virtually unlimited control over shadow density and contrast using the image
control settings of most page layout applications.

placed eps file

: e

+ Align letters, convert to outlines, select all and fill with black.
# Save the outlines as an Encapsulated PostScript (EPS) file. This file contains

placed tiff file
a bitmap image of the characters when placed into a page layout application.

¢ Using a screen capture utility, such as Mainstay’s Capture™, create a screen dump of the black filled outlines.
This is best done while still in the illustration application that you used to align and fill the letters. Most screen
capture utilities, as well as the Command-Shift-3 key sequence built into the Macintosh, save screen dumps as PICT files.
¢ Open the screen dump file with a image editing application such as Adobe Photoshop®.
+ Using a Blur command, soften the screen dump several times in succession. The screen dump image should look smooth,
without any rough edges for the best results. The smoother the final image, the more realistic the shadow will appear.
Save the softened image as a TIFF format file.
Back in your page layout application, place the TIFF file onto a page. Place the original EPS file on top of the TIFF file.
Position the EPS file above and to the right or left of the TIFF file. The black characters should appear as if floating

* & o o

To adjust the appearance of the shadow, select the TIFF file and use the image control features of your particular page
layout program to adjust its brightness and contrast. See the next page for examples.

Adjusting the Soft TIFF Shadow

By using the image control settings available in most page layout applications, you are able to make adjustments to the TIFF file.
These adjustments gives you a wide range of control over the intensity, brightness, contrast and grey value levels of the shadow.
The following examples use the Image Control of Aldus PageMaker®, but most page layout applications have similar features.

figure 33
TIFF file using default image control settings.

Using the default settings yields a satisfactory looking shadow. See figure 33. In most cases, this setting is sufficient.
However, by adjusting the brightness and contrast of the shadow, the effect can be maximized. See the examples below.

figure 34
TIFF file after adjusting the brightness.

By increasing the brightness level of the entire TIFF file using the image control settings, the shadow softens even more.
A softer shadow increases legibility of the characters. The implied light source also appears more believable. See figure 34.

flguwre 35
TIFF file after adjusting the brightness & contrast.

To produce an extremely subtle shadow beneath the characters, increase the brightness and lower the contrast of the TIFF file at
the same time. The shadow in this example looks as if it was produced by a very diffused, low intensity light source. See figure 35.

Cast Shadow
This shadowing method increases the three dimensional appearance of lettering. The light source is effectively horizontal to
the characters, creating a long shadow similar to one at sunset. Vary the amount of skew to achieve the most effective shadow.

top group
" filled 100% black skewed 20" vertically

# Align letters and convert to outlines. . \
# Select all of the characters and fill with 100% black. ';SI;";OE;";ECK/
# Group all characters, then copy and paste the group directly behind the original. skewed 100" horizontally 20" vertically
# TFill the bottom group with 20% black.

¢ Skew the bottom group 100 horizontally from the bottom left hand corner of the characters.

# Select both groups. Skew them 20" vertically from the bottom left hand corner of the characters.
This gives the whole group of characters a more realistic three dimensional look.

Three Dimensional Tube
Creates a three dimensional tube effect to simulate a neon sign. This technique can be especially effective if produced in color,
however the black & white version described here is still quite striking.

top group
- » L filled white no stroke

+ Align letters and convert to outlines.
@ Select all of the characters and fill with 50% black.

: < : bottom group et
¢ Add a 50% black stroke to the characters with a weight of around 8 points. filled 50% black 8 point stroke
.
.

Group all characters, then copy and paste the group directly on top of the original.

Change the fill and stroke of the new group. The amount of change will depend on the final effect you

want. For this example subtract 5% from the fill and stroke color and subtract 1 point from the weight of the stroke.
+ Copy the current group, paste it in front of the other groups, lighten the color of the characters and reduce the stroke weight.
¢ Repeat this pattern until the top group of characters has a fill of 0% (or white) and no stroke.
# Try varying the amount of change in the levels of fill and weight of the stroke to achieve different effects.
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Pattermned Fill in Adobe Illustrator®

This method of filling characters opens up the user to a virtually unlimited range of creative effects. Patterned fills can contain

any combination of lines, shapes, colors, shades or objects that conform to Adobe Illustrator’s Custom Pattern specifications.

+ Align letters and convert to outlines.
¢ Draw a box with the rectangle tool and fill with a shade

of grey. This will be the base of the pattern fill. See figure 36.
< VWithin the boundaries of the box, draw and arrange a group

of elements to be used as the custom pattern. See figure 37.
¢ Select both the pattern elements and the box.
Choose Pattern... from the Paint menu.
< In the Pattern dialog box, click the New button, name the
pattern and then click the OK button. The new pattern is
saved in the Adobe Illustrator document and may be used

as a style of fill. See figure 38.

Change name to:

+ Select the characters and choose Style.. from the Paint menu.
Click on the Pattern radio button in the Fill section of the
dialog box. Select the new pattern from the list. See figure 39.

O Process Color
O ustam Colar
@ Pattern

¢ You can manipulate the pattern fill of the characters even

further by using the pattern transform function found in the
Style... dialog box. Click on the Transform.. button. See figure 40.

+ A dialog box appears allowing you to change the scale, shear

angle, rotation and position of a custom pattern. See figure 41.

m
Experimenting with transformed patterns is a great way to }Fg"ﬁ'_‘j T
e

O ngied:

discover exciting new text effects. ‘

Creative Fills in Aldus FreeHand®

figure 36
Drawing the pattern rectangle.

fignre 37
Adding the pattern elements.

fizgnre 38
Creating & naming the new pattern.

figure 39
Applying the pattern as a fill.

flgure 40
The pattern transform button.

figure 41
The pattern transform dialog box.

Curved Letters
This is way to achieve a TypeStyler like effect on a line of type in an illustration program like Adobe Illustrator
or Aldus FreeHand. It give you precise control over every anchor point and the final shape of each character.

(ENTURION

+ Align letters and convert to outlines.

flgure 45
Positioning the guideline shape.

GENIGI

# Draw a circle or ellipse larger than the group of letters and position it
directly below the group of letters. This shape will be used as a guide-
line for modifying each of the characters in the headline. See figure 45.

« Ungroup the characters so that each of the control points in the
characters can be moved individually.

< Pull out the control points on the bottom of each character

and drag them to meet the edge of circle. See figures 46 & 47.
¢ Once all of the characters have been modified, add fill & stroke.
¢ Delete the guideline shape.

[ENT!IBI(I/’/

+ You can also curve the top and the sides of the letters.

figure 46
Pulling out control points to meet the shape.

figunre 47
The finished character modifications.

Type Distortion in Adobe Photoshop®
Adobe Photoshop has tools and features that are not available in any other graphic design program. While most people would

think that these tools are meant strictly for modifying or manipulating photographs and scanned images, there is no reason why

they can’t be applied to typography as well. Play around and have some fun.. you might just find the effect you've always wanted.

waterwalker == -

+ Align letters and convert to outlines. e
& Export the outlines as an Adobe Illustrator compatible EPS file.
18K figure 48

¢ In Adobe Photoshop, choose Open As.. from the File menu.
+ Choose EPS from the File Format pop up menu. See figure 48.

Choosing the EPS file format.

Creates a uniform, customized fill for your lettering using Aldus FreeHand. This type of fill effect has a flexible
range of characteristics and can easily add depth and dimensionality to a flat headline. The variations are limitless.

An EPS Input Options.. dialog box appears. Check the Anti-aliased check box. If using the artwork at 100% of it’s original size,
set the resolution to double what your final output will use as a screen frequency. For example, if your final artwork will be

Fill and line
Color: From [EiF 30% gray |

+ Align letters and convert to paths. %

¢ Select all characters and group them. ik H:':e

¢ Assign a graduated fill to the group of characters. See figure 42. @*
———— o — Fill and line

& For different effects try addmg a second group of characters ik m

Color: From

beneath the first group and assign a different graduated fill..

SunSET

& _or try a radial fill instead of a linear fill.. See figure 43. ?:m
W [Z 50 .si‘

e, [ & T
ﬁ‘sﬂﬂg‘ 2 : 2 ;,f;?‘
bt

5

« ..or how about a patterned fill. See figure 44.

ftgure 42
Setting the attributes for a
Graduated Fill in Aldus FreeHand.

ffgmre 43
Setting the atiributes for a Radial
Fill in Aldus FreeHand.

figure 44
Setting the attributes for a
Patterned Fill in Aldus FreeHand.

output with a 133 line per inch screen, set the resolution to 266 pixels per inch in the dialog box. See figure 49.
# Once the artwork is in Photoshop, experiment using different filters and effects. The example below uses the Wind filter.

waterwalker =

wio:
Resolution:

} EH

+ How about a gradient fill and the Zigzag filter?

Mode: Constrain Proportions

gg;;ucitl::f [ Anti-aliased
O CMYK Color figure 49
EPS Input Options dialog box.

# To reflect text in water, duplicate it and flip it vertically. Cut the duplicate and paste it with 50% transparency over a
gradient fill. Apply the Zigzag filter to the duplicate to simulate the water surface. See figure 50 for suggested settings.

O Pond ripples
@® Out from center
© Around center figure 50

Pl

+ Save your artwork as an EPS format file. You will then be able to place this file back into most applications.

F hop Zigzag filter settings.
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TROUBLESHOOTING

INSTALLED FONT DOES NOT APPEAR IN FONT/DA MOVER

Solution

If you are installing bitmap screen fonts, use version 3.8 or newer of Font/DA Mover. If you are installing TrueType fonts, use

version 4.1 or newer. Current versions of Font/DA Mover are available from any Apple Computer dealer, free of charge.

INSTALLED FONT DOES NOT APPEAR IN APPLICATION FONT MENU

Solution
Quit the application and launch it again.
Solution

If you have installed font using the Font/DA Mover, restart you Macintosh and then launch the application.

Solution

Call the manufacturer of the application, and ask if your version of the application is compatible with Image Club fonts.

Applications with known compatibility problems are:

¢ Aldus PageMaker® version 3.0 and earlier
WordPerfect® version 101 and earlier
CricketDraw™ version 11 and earlier
MacDraft™ version 2.0 and earlier
Microsoft® Word version 1.05 and earlier
Microsoft® Excel version 1.6 and earlier

® ¢ & 6 o o

Brgderbund TypeStyler™ version 15.2 and earlier

ITALIC FONTS DO NOT APPEAR IN APPLICATION FONT MENU

Solution

To use the italic version of a font, select the base font from the Font menu, and then select the Italic style from the Style menu.
This method will use the true italic version of the font, if one was supplied with the font family.

FONTS PRINT AS IF DOUBLE STRUCK

Solution

Make sure that you have select the Bold version of the typeface from the Font menu, and that the style of the font is Plain.

FONTS APPEAR JAGGED ON SCREEN

Solution
Make sure that you have installed all sizes of the bitmap screen fonts supplied with the font.
Solution

If you are using Adobe Type Manager (ATM), make sure it is installed correctly and turned on.

Solution

If you are using ATM, restart your Macintosh and try the font again.
Solution

If you are using ATM, check to see that the font you are using is a Type 1 PostScript font.

J111)

=== ~HIM™

Adobe lypeManager,

Personalized for:
G. Hutchinson
Image Club Graphics, Inc.

Version 2.0.3

AT Font Cache | Prederve

) OLiespacing
o | B Q ®

aracter shapes

et
© 1983-1991 Adobe Systems Incorporated.
All Rights Reserved. Patents Pending. figure 51

Adj 1g the Font Cache in Adobe Type Manager.

Solution

Increase the Font Cache setting in the ATM control panel and restart your Macintosh. See figure 51.

TROUBLESHOOTING

FONTS APPEAR JAGGED IN PRINTED DOCUMENT
Solution
Make sure that you have installed both the bitmap screen fonts and the PostScript printer fonts.
Solution
If you have installed the fonts under system 6.0, make sure that the PostScript printer fonts are loose in the System Folder.
If you have installed the fonts under system 7.0, make sure the PostScript fonts are in the Extensions folder.
Solution
If you are using a font handling utility such as SuitCase II, make sure that the PostScript printer fonts are on the same level of the
folder that contains the bitmap screen fonts.

FONTS APPEAR IN COURIER FONT IN PRINTED DOCUMENT
Solution \
Make sure that you have installed both the bitmap screen fonts and the PostScript printer fonts.
Solution
If you have installed the fonts under system 6.0, make sure that the PostScript printer fonts are loose in the System Folder.
If you have installed the fonts under system 7.0, make sure the PostScript fonts are in the Extensions folder.
Solution
If you are using a font handling utility such as SuitCase II, make sure that the PostScript printer fonts are on the same level of the
folder that contains the bitmap screen fonts.

PRINTER RESTARTS OR POSTSCRIPT ERROR OCCURS WHEN PRINTING DOCUMENT
Solution
You may have too many fonts in the document, or the printer may not have enough memory to handle all of them at once.
Remove some of the fonts from the document and try printing it again.

AN ERROR MESSAGE WITH A ID NUMBER -61 APPEARS WHEN INSTALLING FONTS
Solution
The System file in your System Folder is locked. Select the System file and choose Get Info from the File menu to open the Info
window. Uncheck the Locked check box in the Info window. See figure 52.

e Info S

. Locked
—'|  System
—= System Software Yer: 0.5

Kind : System document
Size: 433,732 bytes used, 424K on disk

Where: Hard Drive, SCSI 0

Created: Wed, Mar 7, 1990, 12:00 PM
Modified: Tue, May 5, 1992, 6:25 PM
Yersion: 605, © 1983-90 Apple
Computer, Inc.

fitgure 52
Unlocking the System File in the Info Window.

CANNOT CONVERT FONT TO OUTLINES OR PATHS
Solution
If you are using Adobe Illustrator®, you can only create outlines from Type 1 PostScript fonts. If you installed Type 3 PostScript or
TrueType fonts, you will not be able to create outlines.

Could not convert the character(s) to
paths, because the outline font file is in
an unknown format.

L3
%“ fligunwre 53

Unk  font file format dialog box in Aldus FreeHand.

Solution
If you are using Aldus FreeHand®, make sure the “FreeHand Filters” file is located in the Aldus folder found in the System Folder
on your Macintosh. Without this file, Freehand cannot convert fonts to paths. See figure 53.

19




NOTES




